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1. INTRODUCTION 
 
This ADAPT-PT/RC 2019 Getting Started Guide is intended to be used as a practical 
example and guide for modelling a 2D post-tensioned two-way slab frame in the PT mode 
of the program.   
 
While the example is related to a specific system type (two-way slab) the workflow 
applies to input of one-way slabs and beams. 
 
For additional information, refer to the ADAPT-PT/RC 2019 Getting Started Guide for 
RC mode and the ADAPTPT/RC 2019 User Manual.  Both documents can be accessed 
from the HELP menu of the program. 

 
After installation of PTRC 2019 is completed, user should have a desktop icon of the 
same. 

 

It is recommended to right click on the desktop icon and choose 
option to launch the program in administrator mode. The opening screen will be as shown 
below. 

 

 
FIGURE 1-1 PTRC 2019 OPENING SCREEN 

 
This screen gives the option to select a design mode. Select the “Post-Tensioned” option 
and click on “OK” to open ADAPT-PT/RC 2019 basic screen. 
 
ADAPT PTRC is a 2D frame analysis solution. The GUI consists of a main window with 
menu bars and toolbars which are used to feed input data into wizard-based Input Forms 
to create the model.  
 
This model is then solved, and result & reports generated from the solution in different 
user-friendly formats. The typical GUI of PTRC basic screen are as shown in the nest 
figure. 
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FIGURE 1-2 ADAPT PTRC USER INTERFACE 

 
2. TUTORIAL PROBLEM 

 
The objective of this tutorial is to explain how a floor strip or frame line is idealized from 
a complete floor system and modelled as a slab or beam-frame ADAPT-PT/RC 2019.  
 
This tutorial will demonstrate the step-by-step procedure in the PT mode of 
ADAPTPT/RC 2019 to generate data, analyse and design a column-supported slab which 
is a part of a floor system. 
 
The following figure shows a typical floor system with the shaded part of the strip selected 
for present design. This is a 3-span column supported slab with cantilever extensions on 
both sides. 
 

 
FIGURE 2-1 PART PLAN OF SLAB SHOWING STRIP 
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The centre line lengths and tributary widths are identified from the plan which is as shown 
in following figure. 

 

 
FIGURE 2-2 STRIP DETAILS 

 
Next, user needs to idealize the design strip widths along each span on both sides as shown 
in the following figure. 
 

 
FIGURE 2-3 SLAB IDEALIZED STRIP DETAILS 

 
Finally, inclined spans need to be straightened as shown in figure hereafter. 
 

 
FIGURE 2-4 SLAB IDEALIZED STRIP FOR PT/RC INPUT  

 
The following table provides design specifications for this model. Other data if required 
will be assumed during the design process. 
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TABLE 2-1 DESIGN SPECIFICATIONS 

Items Descriptions 
Design Code  IS 456:2000 (Reaffirmed in February 2016) 

 IS 1343:2012 (Reaffirmed in November 2017) 
PT Design Classification  Type 3  

 Allowable Crack Width = 0.2 mm 
Geometry Details  All Slab Depth  = 200 mm 

 All slab end conditions = Interior 
Story Heights  Both Top & Bottom Story Height = 3 m 

Loading Details  Uniform loads : SDL = 2 kN/m2, LL = 4 kN/m2  

Material Design Grades  Concrete = M40 for all members 
 Reinforcement = Fe500 
 Post Tensioning = Low Relaxation Bonded System 
 Strand Area = 98 mm2 
 Ultimate strength, fpu = 1860 N/mm2 
 Effective (long term) stress, fse = 1200 N/mm2 

Reinforcement Details :  Mesh Reinforcement = 8mm dia. @ 300 mm c/c 
Both-ways at Bottom only 

 Main Reinforcement = 12 mm dia. Top & Bottom 
 Shear Reinforcement = 10 mm dia. Stirrups 

Minimum Cover :  25 mm clear cover for reinforcements 
 40 mm cover to CGS for tendons 
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2.1. INPUT AND MODEL GENERATION  
 
2.1.1. General Settings & Design Code 
 
Open a new project by clicking either the “New Project”  icon on the Main Toolbar or on 
the menu File | New. This automatically opens the General Settings input screen. Select 
“Two-Way Slab” as structural system and other details as shown in figure hereafter.  

 

 
FIGURE 2-5 GENERAL SETTINGS INPUT SCREEN 

 
Note that the “Title” inputs are not mandatory and are merely for documentation purpose 
only. Click on Next >> button to continue. 
 
This opens the Design Code selection option screen. Select Indian – IS1343 (2017) 
option as shown in figure hereafter and click on Next >> button to continue. 

 

 
FIGURE 2-6 DESIGN CODE SELECTION 

 
2.1.2. Design Settings 
 
This opens the “Design Settings” input screen. Select the analysis and design options 
through the Design Settings dialog box as shown in figure hereafter. Note that user can 
disregard certain design options of the code here. Click on Next >> button to continue. 
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FIGURE 2-7 DESIGN SETTINGS INPUT 

 
 

2.1.3. Span Geometry 
 
This opens the “Span Geometry” input screen. This screen is used to enter the span 
geometry of the slab which can be modelled as prismatic (uniform) or non-prismatic (non-
uniform). Note that the design strips idealized in previous figure would require the input 
of right and left multiplier values (“<- M” and “M ->”). The table below shows simple 
calculation required for the same based on the ratio of the tributary width to the total 
width of each span.  
 
TABLE 2-2 CALCULATION OF LEFT (<- M) & RIGHT MULTIPLIER (M - >) 

Particulars SPAN 1 SPAN 2 SPAN 3 R-CANT Units 
Span (L) 6.083 9.265 7.102 2.000 m 

Overall Depth (h) 200 200 200 200 mm 

Left Tributary Width 4000 2400 3600 3000 mm 

Right Tributary Width 2500 4700 3000 3000 mm 

Total Width 6500 7100 6600 6000 mm 

Left Multiplier (<- M) 0.62 0.34 0.55 0.50 Factor 

Right Multiplier (M ->) 0.38 0.66 0.45 0.50 Factor 

 
“Rh” value should be kept equals to the slab depth which shall move the reference plane 
to the bottom of the slab. Note that all legends are already provided in the screen. Enter 
the data as given in following figure in the input screen. 
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FIGURE 2-8 SPAN GEOMETRY INPUT 

 
The graphical views of the structure are shown form the “Structure View” window in plan 
and elevation view as shown hereafter. Note that the graphical view is for viewing only 
and no data can be changed or edited from the same. 

 
FIGURE 2-9 PLAN VIEW 

 

 
FIGURE 2-10 ELEVATION VIEW 

 
This page can also be accessed in an existing project from menu Geometry | Span 
Geometry, Verify the input data carefully and click on Next >> button to continue. 

 
2.1.4. Support Geometry and Stiffness 
 
This opens the “Support Geometry and Stiffness” input screen. This screen is used to 
input column heights, widths and depths. This page also provides users the options: 
 

 To consider Lower and/or Upper Columns 
 To enter some percentage of column stiffness for analysis purpose 
 To enter the position of tributaries to be interior/exterior condition for both edges 
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 To consider mathematical point support using “No Column” option. 
 

 
FIGURE 2-11 SUPPORT GEOMETRY & STIFFNESS INPUT 

 
This page can also be accessed in an existing project from menu Geometry | Support 
Geometry. Enter the data as shown above and click on Next >> button to continue. 

 
2.1.5. Support Boundary Conditions 
 
This opens the “Supports – Boundary Conditions” input screen as shown in following 
figure. This screen is used to enter support widths and column boundary conditions. 
Support widths can be entered if the “Reduce Moments to face of- support” option in the 
Design Settings screen was selected as “Yes”. However, if it was selected as “No”, no 
values can be entered in the SW column. This input value will be used to calculate the 
reduced moments. Turn on the “SW=Actual Width of Support” options to automatically 
fill up the support width (SW) values. 

 

 
FIGURE 2-12 SUPPORT BOUNDARY CONDITIONS 

 
This page can also be accessed in an existing project from menu Geometry | Boundary 
Conditions. Enter the options / data as required and click on Next >> button to continue. 
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2.1.6. Loads 
 
This opens the Loads input screen. This page allows users to specify a variety of load 
types. To enter a load for all spans, enter ‘all’ or ‘ALL’ as the span number and select 
load “Class” from the drop-down menu. Enter “U” in the “L/T-?” column as shown in the 
legends at the top. Next enter the load values in uniform load (i.e. “w” column) as shown 
below. 

 

 
FIGURE 2-13 ALL SPAN LOAD INPUT 

 
Click on Next >> button to go to the next screen and << Back button to check that all 
loads are entered in all spans automatically as shown hereafter. 

 

 
FIGURE 2-14 LOAD INPUT FORM (FINAL) 

 
Also note that following points in this context – 

 
 The load class SW is for self-weight of the structure which will be available only 

if user selects “No” to the “Include self-weight option. 
 

 When the Skip Loading function is used, the program considers those 6 patterns 
shown in figure below. The program reports deflections at all 1/20th points along 
spans for all skip patterns and enveloped Max and Min results in report Section 
36. 
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FIGURE 2-15 SKIP PATTERNS 

 
This page can also be accessed in an existing project from menu Loads. Check the data 
as said before and click on Next >> button to continue. 
 
2.1.7. Concrete 
 
This opens the “Material – Concrete” input page as shown in following figure. This screen 
is used to enter concrete properties. The value of “Modulus of Elasticity …” changes 
automatically based on standard formulae as specified in the user selected codes on 
clicking on that field. Refer user manual for details. 

 

 
FIGURE 2-16 MATERIAL - CONCRETE INPUT 

 
This page can also be accessed in an existing project from menu Material | Concrete. 
Enter the options / data as required and click on Next >> button to continue. 

 
2.1.8. Reinforcement 
 
This opens the “Material – Reinforcement” input page. This screen is used to specify mild 
reinforcing bar sizes and properties for longitudinal and shear reinforcement.  
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FIGURE 2-17 MATERIAL - REINFORCEMENT INPUT 

 
This page can also be accessed in an existing project from menu Material | 
Reinforcement. Enter the options / data as shown in figure and click on Next >> button 
to continue. 

 
2.1.9. Post-Tensioning 
 
This opens the “Material – Post-Tensioning” input page. This screen is used to input the 
post-tensioning system parameters. This option is available in PT mode only.  

 

 
FIGURE 2-18 MATERIAL - POST-TENSIONING 

 
This page can also be accessed in an existing project from menu Material | Post-
Tensioning. Enter the options / data as shown in figure and click on Next >> button to 
continue. 

 
2.1.10. Non-Prestressed Base Reinforcement 
 
This opens the “Base Non-Prestressed Reinforcement” input page. If user selects “Yes” 
then remaining part of the page is displayed. The program allows user to specify a base 
reinforcement that is taken into consideration when designing the structure. User has an 



 

ADAPT PTRC 2019 – Getting Started Guide (Indian Code)  12 

option to define reinforcement as mesh or isolated longitudinal bars for all system types 
and stirrups for one-way slabs and beams. 

 

 
FIGURE 2-19 BASE NON-PRESTRESSED REINFORCEMENT 

 
This page can also be accessed in an existing project from menu Criteria | Base Non-
Prestressed Reinforcement …. Enter the options / data as shown before and click on 
Next >> button to continue. 

 
2.1.11. Allowable Stresses 
 
This opens the Criteria – Allowable Stresses input page as shown in following figure. 

 

 
FIGURE 2-20 CRITERIA - ALLOWABLE STRESSES 

 
This screen is used to enter/select allowable stresses for different design classifications. 
The general architecture of the “Design Classification” are enumerated in the following 
table. 
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TABLE 2-3 DESIGN CLASSIFICATION AS PER INDIAN CODE 

Type Tensile Stress (MPa) Remarks 
Initial  

(Transfer) 
Service  

Sustained 
Service  
Total 

Type 1 0.22 √fcki 0.0 0.0 No tensile stress is allowed in 
service condition. 

Type 2 (v1) 0.22 √fcki 3.0 3.0 If tensile stress occurs in service 
sustained condition. 

Type 2 (v2) 0.22 √fcki 0.0 4.5 If no tensile stress occurs in service 
sustained condition. 

Type 3 0.22 √fcki As calculated from 
Table 10 and Figure 6 

of IS 1343 : 2012 

Design is based on cracked 
section. 

 
Please refer “ADAPT Indian Code Implementation” document for details on the same. 
Please note the following points from the above table as a special mention: 

 
 Design classification of Type 2 as per code is broken down into two sub options, viz. 

“Type 2(v1)” and “Type 2(v2)” based on whether Tensile stress occurs in Service 
Sustained condition or not.  

  “Crack Width” is allowed only in “Type 3” till a maximum value of 0.3mm. 
 Only Design “Type 3” values are editable so that user can enter their own values as 

deemed fit. The defaults are automatically loaded when the type is shifted to any other 
type. 

 User has flexibility to control the way this option works from “Design Settings” window 
by disregarding relevant and available options of the code based on their specific 
requirements. 

 These options are a new-feature for ADAPT PTRC 2019 version and is available only 
when user selects the latest Indian code of design, i.e. “Indian-IS1343 (2017)”. 

 
This option is applicable to PT mode only. This page can also be accessed in an existing 
project from menu Criteria | Allowable Stresses. Click on Type 3 option and leave the 
default values here. Click on Next >> button to continue. 

 
2.1.12. Recommended Post-Tensioning Values 
 
This opens the Criteria – Recommended Post-Tensioning Values input page as shown 
in following figure. This screen is used to specify minimum and maximum values for 
average precompression (P/A: total prestressing divided by gross cross-sectional area) 
and percentage of dead load to balance (Wbal).   
 
These values are used by the program to determine the post-tensioning requirements and 
the status of the “Pmin/Pmax” and “WBAL Min/ Max” indicators on the “Recycle 
window”. 
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FIGURE 2-21 CRITERIA - RECOMMENDED POST-TENSIONING VALUES 

 
This option is applicable to PT mode only. This page can also be accessed in an existing 
project from menu Criteria | Post-Tensioning…. Enter the options / data as shown 
before and click on Next >> button to continue. 

 
2.1.13. Calculation Options 
 
This opens the Criteria – Calculation Options input page as shown in following figures. 
This screen is used to select the post-tensioning design options, viz., Force Selection and 
Force/Tendon Selection. The same is described in following sections. 

 

2.1.13.1. Force Selection 

 
In Force Selection option, a tendon will be assigned a final and constant effective force, 
equal to the jacking force minus all stress losses, expressed as a single value as shown in 
following figure. Select Calculate force/number of tendons option to continue. 

 

 
FIGURE 2-22 CRITERIA - CALCULATION OPTIONS: FORCE SELECTION 

 

2.1.13.2. Tendon Selection 

 
If Calculate force/number of tendons option is specified, the screen shall expand to 
present additional inputs required to calculate the detailed prestressed losses.  
 
Long-term losses may either be entered as a lump sum value, or the information required 
to calculate them may be entered. These values of prestressing material constants and 
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shall be generally found PT strand manufacturer’s document or may also be entered based 
on industry standard. The same is shown in figure hereafter. 

 
This option is applicable to PT mode only. This page can also be accessed in an existing 
project from menu Criteria | Calculation Options …. Enter the options / data as shown 
hereafter and click on Next >> button to continue. 

 

 
FIGURE 2-23 CRITERIA - CALCULATION OPTIONS: TENDON SELECTION 

 
2.1.14. Tendon Profile 
 
This opens the Criteria – Tendon Profile input page as shown in figure hereafter.  

 

 
FIGURE 2-24 CRITERIA - TENDON PROFILE 

 
The program allows user to specify up to three tendon paths per span. User can define 
one profile for each of the three tendons. In the section Option for tendons, user can 
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define the Default extension of terminated tendon as fraction of span. Also, User can also 
specify the Shape of tendon extension from the Left end and the Right end. 

 
This option is applicable to PT mode only. This page can also be accessed in an existing 
project from menu Criteria | Tendon Profile. Enter the options / data as required and 
click on Next >> button to continue. 

 
2.1.15. Cover for Reinforcement and Post-Tensioning 
 
This opens the Criteria – Cover / CGS input page as shown in following figure. Note 
that the cover for the pre-stressing steel is specified to the centre of gravity of the strand 
(CGS) whereas, for mild steel, it is clear cover. 

 

 
FIGURE 2-25 CRITERIA - COVER / CGS 

 
This page can also be accessed in an existing project from menu Criteria | Minimum 
Covers. Enter the options / data as mentioned and click on Next >> button to continue. 

 
2.1.16. Minimum Bar Extension 
 
This opens the Criteria – Minimum Bar Extension input page as shown in following 
figure.  

 

 
FIGURE 2-26 CRITERIA - MINIMUM BAR EXTENSION 
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This screen is used to define how mild steel reinforcement bar lengths are calculated. This 
page can also be accessed in an existing project from menu Criteria | Minimum Bar 
Extension …. Enter the options / data as required and click on Next >> button to 
continue. 

 
2.1.17. Reinforcement Curtailment 
 
This opens the Criteria – Reinforcement Curtailment input page as shown in following 
figure. This page can also be accessed in an existing project from menu Criteria | 
Reinforcement Curtailment …. 

 

 
FIGURE 2-27 CRITERIA - REINFORCEMENT CURTAILMENT 

 
This screen is used to define how mild steel reinforcement bar lengths are calculated. 
Enter the options / data as required and click on Next >> button to continue. 

 
2.1.18. Load Combinations 
 
This opens the Criteria – Load Combinations input page as shown in following figure. 
The program allows users to specify four strength, two service sustained and two service 
total load combinations.  
 
The default load combinations are already loaded for the current code selection  here. The 
Initial load combination is only active for the PT mode.  
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FIGURE 2-28 CRITERIA - LOAD COMBINATIONS 

 
This page can also be accessed in an existing project from menu Criteria | Load 
Combinations …. Enter the options / data as shown before. 

 
This completes the input definition of the project data. To save the input data and execute 
the analysis, either select Execute on the menu bar or click on the Save & Execute 

Analysis button .  
 
In PT mode the program can be executed in Automatic or Interactive mode from Design 
Settings screen. In RC mode the program is run in automatic mode only. Refer user 
manual for details. 
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2.2. EXECUTION AND OUTPUT 
 

2.2.1. Recycling Window 
 
Once the execution gets completed, the PT Recycling window, as shown in figure 
hereafter opens. If an error is detected, the program will stop and display a message box 
indicating the most likely source of the error. The data consistency checks are not 
exhaustive, however, which means that the user is ultimately responsible for ensuring that 
the data is entered correctly. 

 

 
FIGURE 2-29 PT RECYCLING WINDOW 

 
The PT Recycling window is comprised of five tabs which display information about the 
post-tensioning design, a Design Indicator box which summarizes the status of the current 
design, a Status indicator and four control buttons: Recycle, Recall, Graphs and Exit.  
 
User can revise the design data using editable data in the tabs to modify tendon profile, 
force, number and extents to obtain desirable outcome mainly from the tabs namely, 
Tendon force and height (1) and Tendon selection and extents (5). Each revision should 
be followed by a click in the Recycle button to update the results with the revised data. 
In an existing design project with a solution available user can also click on Recall button 
to recall the previously edited design data saved in the solution folder. Once an acceptable 
solution is reached click on Exit button to accept the calculations and proceed to report 
preparation.  
 

For example, click on the  button on the Recycle screen to get the graphs as shown 
in following figure. 
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FIGURE 2-30 RECYCLE GRAPH 

 

In this case all design status is Ok, hence click on button on the Recycle Screen to 
accept the solution and move ahead to prepare reports. 
 
2.2.2. Execution Completed 
 
Once successfully finished, program returns to the main program window. The Results 
can be viewed and/or printed as Reports, Graphs and PT Summary as shown in following 
figure. 

 
FIGURE 2-31 EXECUTION COMPLETED 
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2.2.3. Show Graphs 
 

The user can now select the Show Graphs button to view all the results graphs. This 
option can also be invoked from the menu View | Graphs and selecting the appropriate 
items from the sub-menu. Several graphs are shown to depict all design conditions like 
Moment, Shear, Deflection, Stress etc.  
 

 
FIGURE 2-32 SERVICE TOTAL - TOP STRESS DIAGRAM 

 
These graphs clearly demonstrate allowable and actual design data. User can right click 
on the graphs and modify these graphs to show different data labels including options to 
Export the graph to different formats as shown in the following figure. 

 

 
FIGURE 2-33 ANNOTATION OPTIONS FOR GRAPHS 
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2.2.4. Report Generation 
 
ADAPT-PT/RC 2019 has a powerful Report Generator. To generate the report, select the 

Report Setup item on the Options menu or click the Report Setup button  on the 
main toolbar. The Report Generator screen shown in following figure will open. 

 

 
FIGURE 2-34 REPORT GENERATOR 

 
Select the data as given here and click on Create New Report, save the location  and file 
name as required and click on Save. Software would run all the reports automatically and 
generate the report in RTF and XLS format. Please wait until the report in compiled and 
the RTF and XLS file is opened for review. The following figure shows an excerpt from 
the report generated. 

 

 

 
FIGURE 2-35 EXCERPT FROM RTF FORMAT REPORT GENERATED 

 
2.2.5. Summary Report 
 

To open the PT Summary Report either click the open BuilderSum  button on the 
tool bar or select the PT summary item on the View menu.  
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A new window named ADAPT-BuilderSum is opened. Click on the  icon to open a 
summary report as shown in figure below. There are other tools which are self-
explanatory. 
 

 
FIGURE 2-36 SUMMARY REPORT 

 
2.2.6. DXF Export 
 

To export the tendon profiles to DXF format, click on the Export to DXF file  button 
on the tool bar or select the Export to DXF file option from the File menu. It opens the 

ADAPT - STRUCTURAL CONCRETE SOFTWARE SYSTEM
ADAPT-PT Version 2019   Date: 12 - 24 - 2019   Time: 14:17   File: PT2019_IS_GSG_2WSPT_Indian

1 - PROJECT TITLE: "THREE SPAN TWO-WAY SLAB INDIAN PT"
1.1 Design Strip: Getting Started Example 1
1.2 Load Case: Envelope

2 - MEMBER ELEVATION
   [m] 6.083 9.265 7.102 2.000

SPAN 1 SPAN 2 SPAN 3 R-Cant

3 - TOP REBAR
3.1 ADAPT selected
3.2 ADAPT selected
3.3 Num. of layers

1 5-12mm X2060 mm2 27-12mm X5820 mm 3 29-12mm X5820 mm 4 8-12mm X4260 mm

5 4-12mm X1480 mm 6 26-12mm X4100 mm 7 29-12mm X4100 mm 8 7-12mm X3720 mm

1 1 1 1 1 1 1 1 1 1 1 1

4 - TENDON PROFILE

4.1 Datum Line

4.2.1 CGS Distance A [mm]

4.3.1 CGS Distance B [mm]

4.4.1 CGS Distance C [mm]

4.2.2 Force A [kN]

4.3.2 Force B [kN]

4.4.2 Force C [kN]

4.5 Force/Width [kN/m]
4.6 Precompression P/A [N/mm^2]

  100   40  40   160
1221.2

  40  40   160
1221.2

  40   160
1221.2

  100  100  100
1221.2

187.88
.94

172.00
.86

185.03
.93

203.53
1.02

5 - BOTTOM REBAR
5.1 ADAPT selected
5.2 ADAPT selected
5.3 Num. of layers

9 27-12mm X24460 mm

1 1 1 1 1 1 1 1 1 1 1 1

6 - REQUIRED & PROVIDED BARS
6.1 Top Bars

      [ mm2]
      required
      provided

6.2 Bottom Bars

max

max

00E+00
17E+02
34E+02
51E+02
68E+02

16E+02
32E+02

1010 3188

498 401 482

5993 6461

639 2956 639

4007 1595

526 417 526

121314001420

7 - PUNCHING SHEAR
 OK=Acceptable
 RE=Reinforce
 NG=Exceeds code
 NA=not applicable
 or not performed

 0.72
- 272.91
147.75

OK

 1.50
- 920.27
229.58

RE

 1.47
- 958.40
- 186.64

RE

 0.92
- 548.33
- 149.80

OK

7.1 Stress Ratio
      Shear Force [kN]
      Bending Moment [kN*m]

7.2 Status

8 - LEGEND Stressing End Dead End

9 - DESIGN PARAMETERS
9.1 Code: Indian-IS1343 (2017)   fck =  40 N/mm2  fy =  500 N/mm2 (longitudinal)    fy =  415 N/mm2 (shear)  fpu =  1860 N/mm2

9.2 Rebar Cover: Top =  25 mm   Bottom =  25 mm   Rebar Table: 

10 - MATERIAL QUANTITIES
CONCRETE
Total volume of concrete = 32.8 m3

Area covered = 164.2 m2

MILD STEEL
Total weight of rebar = 1143.6 kg
Average rebar usage = 6.965 kg/m2, 34.825 kg/m3

PRESTRESSING STEEL
Total weight of tendon = 195.4 kg
Average tendon usage = 1.190 kg/m2, 5.949 kg/m3

11 - DESIGNER'S NOTES
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Export Tendon Profiles and Reinforcement to DXF Drawing dialogue as shown in 
following figure. 

 
FIGURE 2-37 EXPORT TO DXF DRAWING DIALOUGE 

 
Type the drawing title in the area provided and click on Create DXF button to save the 
DXF file. The DXF file is saved within the project data folder as shown in following 
figure. 
 

 
FIGURE 2-38 SAMPLE DXF OUTPUT 

 
This completes this tutorial. Please contact ADAPT Technical Support at 
support@adaptsoft.com for any questions. 
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